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Of	course,	you	can	also	use	formulas	to	find	&	remove	duplicates	in	Google	Sheets.	Their	main	advantage	is	that	your	original	table	remains	intact.	The	formulas	identify	duplicates	and	return	the	result	to	some	other	place	in	your	Google	Sheets.	And	based	on	the	desired	outcome,	different	functions	do	the	trick.	The	UNIQUE	function	scans	your	data,
deletes	duplicates	and	returns	exactly	what	its	name	says	unique	values/rows.	Here's	a	small	sample	table	where	different	rows	reoccur:	On	one	hand,	you	may	need	to	remove	all	duplicate	rows	from	this	Google	Sheets	table	and	keep	only	the	first	entries.	To	do	that,	just	enter	the	range	for	your	data	inside	UNIQUE:	=UNIQUE(A1:C10)	This	small
formula	returns	all	unique	rows	and	all	1st	occurrences	ignoring	2nd,	3rd,	etc.	On	the	other	hand,	you	may	want	to	get	only	the	"real"	unique	rows.	By	"real"	I	mean	those	that	don't	reoccur	not	even	once.	So	what	do	you	do?Let's	take	a	moment	and	look	through	all	UNIQUE	arguments:UNIQUE(range,[by_column],[exactly_once])range	is	the	data	you
want	to	process.[by_column]	tells	whether	you	check	for	completely	matching	rows	or	cells	in	individual	columns.	If	it's	columns,	enter	TRUE.	If	it's	rows,	enter	FALSE	or	just	skip	the	argument.[exactly_once]	this	one	tells	the	function	to	delete	not	only	duplicates	in	Google	Sheets	but	also	their	1st	entries.	Or,	in	other	words,	return	only	records	with
no	duplicates	whatsoever.	For	that,	you	put	TRUE,	otherwise	FALSE	or	skip	the	argument.That	last	argument	is	your	leverage	here.Hence,	to	remove	all	duplicate	rows	from	your	Google	Sheets	completely	(along	with	their	1st	),	skip	the	second	argument	in	the	formula	but	add	the	third:=UNIQUE(A1:C10,,TRUE)See	how	the	table	on	the	right	is
much	shorter?	It's	because	Google	Sheets	UNIQUE	found	and	removed	duplicate	rows	as	well	as	their	1st	occurrences	from	the	original	table.	Only	unique	rows	remain	now.	If	wasting	cells	with	another	dataset	is	not	part	of	your	plan,	you	can	count	duplicates	in	Google	Sheets	instead	(and	then	delete	them	manually).	It'll	take	just	one	extra	column
and	the	COUNTIF	function	will	help.Tip.	If	you're	not	familiar	with	this	function,	we	have	an	entire	blog	post	about	it,	feel	free	to	take	a	look.	Let's	identify	all	duplicates	with	their	1st	occurrences	in	Google	Sheets	and	check	the	total	number	of	each	berry	appearing	on	the	list.	I	will	enter	the	following	formula	in	D2	and	then	copy	it	down	the
column:=COUNTIF($B$2:$B$10,$B2)Tip.	To	make	this	formula	handle	each	row	in	the	column	automatically,	wrap	everything	in	ArrayFormula	and	change	$B2	to	$B2:$B10	(the	whole	column).	Thus,	you	won't	need	to	copy	the	formula	down:If	afterwards	you	filter	this	dataset	by	the	numbers,	you	will	be	able	to	see	and	even	remove	all	duplicate
rows	from	your	Google	Sheets	table	manually:	In	case	the	total	number	of	occurrences	is	not	your	goal	and	you'd	rather	know	whether	this	particular	record	in	this	particular	row	is	the	1st,	2nd,	etc	entry,	you'll	need	to	make	a	slight	adjustment	to	the	formula.Change	the	range	from	the	entire	column	($B$2:$B$10)	to	just	one	cell	($B$2:$B2).Note.
Pay	attention	to	the	use	of	absolute	references.=COUNTIF($B$2:$B2,$B2)Now	deleting	duplicates	from	this	Google	Sheets	table	will	be	even	easier	because	you'll	be	able	to	hide	all	entries	but	the	1st	ones:	All	previous	formulas	count	duplicates	in	a	single	Google	Sheets	column.	But	I	know	a	formula	that	looks	into	all	columns	to	identify	duplicate
rows.In	this	case,	COUNTIFS	will	suit	you	better.	Just	list	every	column	of	your	table	along	with	its	corresponding	criteria:=COUNTIFS($A$2:$A$10,$A2,$B$2:$B$10,$B2,$C$2:$C$10,$C2)Tip.	There's	another	way	available	to	calculate	duplicates	without	formulas.	It	involves	a	Pivot	table	and	I	described	it	above.	Sometimes	numbers	are	just	not
enough.	Sometimes	it's	better	to	find	duplicates	and	mark	them	in	a	status	column.	You	can	filter	this	column	by	statuses	and	remove	those	duplicates	you	no	longer	need.	For	this	task,	you	will	need	the	same	COUNTIF	function	but	this	time	wrapped	in	the	IF	function.	Just	like	this:=IF(COUNTIF($B$2:$B$10,$B2)>1,"Duplicate","Unique")Let's	see
what	happens	in	this	formula:First,	COUNTIF	searches	the	entire	column	B	for	the	berry	from	B2.	Once	found,	it	sums	them	up.Then,	IF	checks	this	total,	and	if	it's	greater	than	1,	it	says	Duplicate,	otherwise,	Unique.Of	course,	you	can	make	the	formula	to	return	your	own	statuses,	for	example,	find	&	identify	only	duplicates	in	your	Google	Sheets
data:=IF(COUNTIF($B$2:$B$10,$B2)>1,"Duplicate","")Tip.	As	soon	as	you	find	these	duplicates,	you	can	filter	the	table	by	the	status	column.	This	way	lets	you	hide	repeated	or	unique	records,	and	even	select	entire	rows	&	delete	these	duplicates	from	your	Google	Sheets	completely:	Similarly,	you	can	mark	absolute	duplicate	rows	rows	where	all
records	in	all	columns	appear	several	times	in	the	table:Start	with	the	same	COUNTIFS	from	before	the	one	that	scans	each	column	for	its	first	value	and	counts	only	those	rows	where	all	3	records	in	all	3	columns	repeat	themselves:	=COUNTIFS($A$2:$A$10,$A2,$B$2:$B$10,$B2,$C$2:$C$10,$C2)	Then	enclose	that	formula	in	IF.	It	checks	the
number	of	repeated	rows	and	if	it	exceeds	1,	the	formula	names	the	row	as	a	duplicate:	=IF(COUNTIFS($A$2:$A$10,$A2,$B$2:$B$10,$B2,$C$2:$C$10,$C2)>1,"Duplicate","")	Now	this	table	has	only	2	dupes.	Even	though	cherry	occurs	3	times	in	a	table,	only	two	of	them	have	all	3	columns	identical.	To	ignore	the	1st	occurrence	and	mark	only	the
2nd	and	the	other	ones,	refer	to	the	first	cells	of	the	table	instead	of	the	entire	columns:=IF(COUNTIFS($A$2:$A2,$A2,$B$2:$B2,$B2,$C$2:$C2,$C2)>1,"Duplicate","")Tip.	If	you	are	using	Microsoft	Excel,	the	following	examples	might	be	helpful:	How	to	find	duplicates	in	Excel.	Did	you	know	that	you	can	spot	duplicates	in	your	table	at	a	single
glance?	All	you	need	to	do	is	highlight	duplicates	in	Google	Sheets.	Conditional	formatting	will	help	you	with	this.Tip.	Visit	this	tutorial	for	more	formulas	to	highlight	duplicates	in	Google	Sheets.Here's	what	you	need	to	do:Open	conditional	formatting	settings:	Format	>	Conditional	formatting.Make	sure	that	the	Apply	to	range	field	contains	the
range	of	cells	where	you	want	to	highlight	duplicates.	For	this	example,	let	me	start	with	column	B.In	Format	rules	pick	Custom	formula	is	and	enter	the	same	COUNTIF	that	I	introduced	above:	=COUNTIF($B$2:$B$10,$B2)>1	Once	it	locates	records	that	appear	at	least	twice	in	column	B,	they	will	be	colored	with	a	hue	of	your	choice:Another	option
would	be	to	highlight	duplicate	rows.	Simply	adjust	the	range	to	apply	the	rule	to	multiple	columns:Tip.	Once	you	highlight	duplicates	in	your	Google	Sheets,	you	can	filter	the	data	by	color:On	one	hand,	you	can	filter	the	column	so	that	only	cells	with	the	white	fill	color	remain	visible.	This	way,	you	will	delete	duplicates	from	the	view:	On	the	other
hand,	you	can	keep	only	colored	cells	visible:	and	then	select	these	rows	and	delete	these	duplicates	from	your	Google	Sheets	completely:	Find	&	remove	duplicates	in	Google	Sheets	(make	yourself	a	copy	to	practice)	When	dealing	with	a	lot	of	data,	you	may	sometimes	want	to	double-check	and	make	sure	no	duplicates	existor,	conversely,	you	may
want	to	highlight	any	duplicates	to	call	attention	to	them.	In	that	case,	you	can	use	a	straightforward	formula	in	Google	Sheets.	Learn	how	to	find	duplicates	in	Google	Sheets	with	step-by-step	instructions.To	begin,	you'll	need	your	tab	open	to	your	spreadsheet.	If	youre	not	already	working	with	your	own	data	set	and	want	to	follow	along	with	our
examples,	make	a	copy	of	this	template	to	practice.How	to	highlight	duplicates	in	Google	SheetsHighlighting	duplicates	in	Google	Sheets	requires	conditional	formatting	using	the	custom	formula	=COUNTIF	(A:A,	A1)>1.	Follow	these	steps	to	learn	how	to	use	it.TIP:	If	youd	rather	not	dive	into	formulas	just	yet,	you	can	download	an	add-on	from
Google	Sheets	that	will	find	and	highlight	duplicates	for	you.1.	Highlight	the	column	you	want	to	find	duplicates	in.Using	our	practice	sheet,	see	if	the	Director	(1)	column	has	any	duplicates.	2.	Click	'Format'	in	the	top	menu.3.	Click	'Conditional	formatting.'This	will	populate	a	box	on	the	right-hand	side	of	the	screen.	Youll	see	a	prompt	called	Format
cells	if	Click	on	that	and	scroll	to	the	bottom.4.	In	the	'Format	cells	if'	box,	click	'Custom	formula	is.'5.	Use	the	COUNTIF	formula	to	find	duplicates.The	COUNTIF	formula	[=COUNTIF	(A:A,	A1)>1]	tells	Sheets	where	to	look	for	duplicates.	The	information	in	the	parentheses	represents	the	column	you	want	to	track	and	the	specific	cell	you	want	to
start	with.	The	information	outside	the	parentheses	states	that	you	want	Sheets	to	count	duplicates	or	anything	appearing	more	than	once	(>1).Since	you're	looking	for	duplicate	directors,	you	want	to	adjust	the	formula	to	read	the	C	column.	Your	formula	should	become	=COUNTIF	(C:C,	C2)>1.	You	can	see	how	it	begins	to	highlight	repeat	directors.
How	to	highlight	duplicate	values	in	Google	Sheets	in	multiple	columnsNow	that	you	know	how	to	count	duplicates	in	one	column,	learn	how	to	adjust	the	process	to	count	duplicates	in	multiple	columns	next.Lets	say	you	want	to	check	movie	titles	and	directors,	so	columns	B	and	C	in	this	case.	Weve	purposely	added	an	error	in	the	titles	column,
repeating	Batman	twice.	Clear	any	previous	conditional	format	rules,	and	repeat	the	steps	above	until	you	get	to	the	box	where	youll	input	your	custom	formula.You	can	go	about	this	in	two	ways:1.	Use	'Apply	to	range.'By	highlighting	the	columns	you	want	to	check,	youll	automatically	tell	Apply	to	range	what	to	concentrate	on,	but	youll	have	to
adjust	your	custom	formula	to	start	with	the	value	of	that	first	column	and	first	row.For	your	purposes,	youre	looking	at	columns	B	and	C,	so	your	function	should	be	=COUNTIF(B:B,	B1)>1.	That	tells	Sheets	to	start	with	B1	and	go	from	there.You	can	adjust	the	range	in	Apply	to	range	as	needed.	Lets	say	you	were	looking	at	columns	B	and	C,	but	now
you	want	to	include	columns	B	through	F.	Rather	than	clear	the	conditional	formatting,	highlight	your	new	columns,	and	start	over,	you	can	simply	update	the	Apply	to	range	to	read	B1:F999.Make	sure	the	syntax	of	your	formula	matches	the	first	value.	For	example,	if	you	want	to	look	at	columns	C	through	F	now,	youll	update	Apply	to	range	to
C1:F999	and	then	make	sure	the	function	reads	=COUNTIF(C:C,	C1)>1.2.	Use	absolute	values.Absolute	values	are	a	way	to	specify	where	Sheets	should	look	for	duplicates	with	the	$	symbol.	Youll	need	to	frame	every	cell	with	a	$.	Our	function	becomes	=COUNTIF	($B$1:$C$50,	B1)>1.Learn	more:	Google	Sheets	vs.	Excel:	What's	the	Difference?
How	to	highlight	multiple	columns	using	different	colorsPerforming	these	steps	will	highlight	your	duplicates	using	one	color.	But	if	you	have	multiple	duplicates,	you	won't	be	able	to	see	how	many	of	each	duplicate	you	have.In	that	case,	youd	want	to	do	a	pivot	table,	which	can	help	you	see	and	better	understand	the	relationship	between
data.Beyond	highlighting	duplicates	in	Google	Sheets:	Continue	exploring	how	to	work	with	data	on	CourseraHighlighting	duplicates	in	Google	Sheets	is	one	way	to	filter	and	clean	your	data.	Interested	in	strengthening	your	abilities	to	work	with	data	using	Google	Sheets?	Enroll	in	the	Google	Data	Analytics	Professional	Certificate.	Youll	learn	more
about	spreadsheets	and	other	key	analysis	tools.	Duplicating	a	page	or	the	complete	document	is	a	great	way	to	save	time	and	effort	when	attempting	to	replicate	your	content	or	create	a	backup	of	the	document.	If	you	use	Google	Docs	as	your	primary	document	editor,	you	might	have	wondered	if	it	is	possible	to	duplicate	a	page	on	the	platform	as
navigating	some	Google	Docs	features	can	be	quite	challenging.	On	Google	Docs,	duplicating	a	page	is	a	good	way	to	completely	recreate	a	document	or	a	specific	page	in	the	document	without	having	to	type	or	input	all	the	existing	texts	and	elements	on	the	document.	You	can	also	duplicate	a	Google	document	if	you	want	to	create	an	extra	copy	for
editing	purposes	while	ensuring	that	the	original	copy	remains	untouched.	In	this	article,	you	will	learn	how	to	duplicate	a	page	in	Google	Docs	easily.	From	using	the	built-in	page	duplicate	feature	to	utilizing	keyboard	shortcuts	and	copying	content,	you	will	learn	the	necessary	steps	to	creating	identical	copies	of	pages	on	your	document.	To
duplicate	a	page	in	Google	Docs,	follow	these	steps.	Open	the	document	in	Google	Docs.	Go	to	the	Google	Docs	menu	bar.	Select	File	>	Make	a	copy.	Enter	a	name	for	the	new	document.	Select	your	desired	options.	Click	Make	a	copy	to	duplicate	the	document.	There	are	quite	a	couple	of	reasons	why	you	might	want	to	duplicate	a	page	in	Google
Docs	and	regardless	of	your	reason	for	duplicating,	the	process	is	the	same.	If	you	want	to	duplicate	a	page	on	Google	Docs,	you	can	simply	select	all	the	text	on	the	document	and	then	copy	and	paste	it	on	a	new	document	or	another	page	on	the	same	document.	That	said,	there	is	an	even	easier	way	to	duplicate	all	pages	on	your	document	and	that
is	by	using	the	Make	a	copy	feature	on	Google	Docs.	Here	is	how	you	can	duplicate	pages	in	Google	Docs.	First,	go	to	the	Google	Docs	dashboard	and	open	an	existing	document	with	the	page(s)	you	want	to	duplicate	in	a	new	window.	If	you	already	have	the	document	open	on	your	web	browser,	you	can	skip	this	step.	Next,	you	will	need	to	make	a
new	copy	of	the	entire	document.	To	do	this,	go	to	the	Google	Docs	menu	bar	then	click	File	and	select	Make	a	copy	in	the	dropdown	sub-menu.	Now	you	should	see	a	dialog	titled	Copy	document.	Change	the	name	of	the	document	to	anything	you	want	or	you	can	simply	just	leave	it	if	you	dont	want	to	rename	it.	By	default,	Google	Docs	will	add	Copy
of	to	the	original	name	of	the	document	and	save	the	new	document	with	that	on	your	drive.	Leave	the	Folder	option	as	it	is	or	change	it	if	you	want	to	keep	the	copy	document	in	a	new	folder.	Check	the	Share	it	with	the	same	people	option	if	you	want	to	share	the	new	document	with	the	current	collaborators	of	the	document	(optional)	and	check	the
Copy	comments	and	suggestions	and	Include	resolved	comments	and	suggestions	options	to	move	over	both	resolved	and	unresolved	comments	to	the	new	document	(recommended).	After	that,	click	Make	a	copy	to	duplicate	the	document.	Now	you	should	see	a	new	Google	Doc	window	with	the	duplicated	document.	Using	the	Make	a	copy	feature
will	duplicate	the	selected	document	on	Google	Docs.	if	you	just	want	to	duplicate	only	one	specific	page	from	the	document,	go	to	the	duplicated	document	and	delete	all	other	pages	except	the	page	you	need.	However,	if	you	want	to	duplicate	the	whole	document,	then	leave	the	document	as	it	is.	In	the	above	method,	we	showed	you	how	to
duplicate	a	page	into	a	different	document,	but	in	some	cases,	you	might	just	need	to	duplicate	a	single	page	on	the	same	document.	To	duplicate	a	page	on	Google	Docs	in	the	same	document,	highlight	all	the	texts	(and	other	elements)	on	the	page	by	either	clicking	and	dragging	with	your	mouse	pointer	or	using	a	key	combination	of	Ctrl	+	A	(or
command	+	A)	on	your	keyboard.	After	highlighting	all	the	text	(and	elements)	on	the	page,	hit	Ctrl	+	C	(or	command	+	C)	on	your	keyboard	to	copy	to	clipboard.	You	can	also	right-click	anywhere	on	the	highlighted	text	and	select	Copy	to	copy.	Next,	go	to	the	end	of	the	current	page	and	place	your	cursor	at	the	end	of	the	text.	After	that,	go	to	the
Google	Docs	menu	bar	then	select	Insert	>	Break	>	Page	break	to	add	a	page	break	and	create	a	new	page.	Alternatively,	you	can	use	a	key	combination	of	Ctrl	+	Enter	(or	command	+	return	for	macOS	users)	on	your	keyboard	to	insert	a	page	break	and	create	a	new	page.	Finally,	go	to	the	new	page	and	hit	Ctrl	+	V	(or	command	+	V)	on	your
keyboard	to	paste	the	text	you	copied.	You	can	also	right-click	anywhere	on	the	new	page	and	select	Paste	to	paste	the	text	you	copied.	And	thats	how	you	can	duplicate	a	page	in	the	same	document	on	Google	Docs.	Its	quite	simple!	If	you	use	the	Google	Doc	mobile	app,	you	might	be	wondering	if	what	we	have	discussed	so	far	is	also	applicable	to
Google	Docs	on	mobile	and	the	answer	is	Yes!	Here	is	how	to	make	a	copy	of	a	Google	Doc	on	mobile.	Open	the	Google	Docs	mobile	app	then	select	the	document	you	will	like	to	make	a	copy	of	(or	duplicate)	by	clicking	on	the	document	preview.	If	you	have	the	document	open	on	the	Google	Docs	mobile	app	on	your	device,	you	can	skip	this	step.
Next,	you	will	need	to	make	a	copy	of	the	document	on	the	app.	To	do	this,	click	on	the	3-dot	icon	on	the	top-right	corner	of	the	document	page	then	select	Share	and	export	from	the	menu	options.	After	that,	click	Make	a	copy	in	the	next	section.	After	that,	just	wait	a	few	seconds	(depending	on	your	network	connection)	and	a	new	copy	of	the	current
document	should	be	created.	To	rename	the	duplicate	document,	go	back	to	the	home	screen	of	the	Google	Docs	mobile	app	then	click	on	the	vertical	3-dot	icon	on	the	preview	of	the	duplicate	document,	select	Rename	from	the	menu	options,	enter	a	new	name,	and	click	Rename	to	rename	the	document.	And	thats	how	you	can	make	a	copy	or
duplicate	a	document	on	the	Google	Docs	mobile	app.	To	highlight	the	whole	page	in	Google	Docs,	go	to	the	top	of	the	page	then	click	and	drag	using	your	mouse	pointer	until	you	get	to	the	bottom	of	the	page.	Alternatively,	you	can	also	highlight	a	whole	page	on	your	document	in	Google	Docs	by	using	a	key	combination	of	Ctrl	+	A	for	users	on
Windows	and	Linux	or	command	+	A	for	macOS	users.	To	duplicate	an	image	on	Google	Docs,	simply	select	the	image	then	hit	Ctrl	+	C	(or	command	+	C)	on	your	keyboard	to	copy	the	image	to	your	clipboard.	You	can	also	right-click	on	the	image	and	select	Copy	to	copy.	After	copying,	right-click	on	the	section	you	want	to	add	the	duplicated	image
to,	then	select	Paste	from	the	available	options.	You	can	also	use	a	key	combination	of	Ctrl	+	V	(or	command	+	V)	on	your	keyboard	to	paste	the	image.	And	thats	how	you	can	duplicate	an	image	on	the	same	document	on	Google	Docs.	If	you	want	to	duplicate	the	image	to	a	separate	document,	simply	go	to	the	document	and	paste	the	image	there,
after	copying.	Yes,	is	possible	to	make	a	copy	for	each	student	on	Google	Docs	by	using	the	Make	a	copy	feature.	While	duplicating	the	document,	add	the	name	of	the	student	to	the	name	of	each	duplicate	and	add	the	Gmail	address	of	the	student	to	the	document	as	a	collaborator	with	editing	roles.	Repeat	this	for	all	the	students	you	want	to	make	a
copy	of	a	Google	Doc	for.	While	this	might	be	quite	challenging,	it	is	the	only	way	to	achieve	this	(for	now)	on	Google	Docs.	In	conclusion,	knowing	how	to	duplicate	a	page	in	Google	Docs	can	save	you	some	valuable	time	and	effort	in	your	document	creation	process.	There	are	a	couple	of	reasons	why	one	might	need	to	duplicate	a	page	on	their
document	and	throughout	this	article,	we	have	explored	various	methods	and	techniques	you	can	use	to	effortlessly	duplicate	pages	on	your	documents.	Duplicating	pages	on	your	documents	can	help	to	replicate	layouts,	formatting,	and	content	with	ease.	To	duplicate	a	page	on	Google	Docs,	you	can	use	the	Make	a	copy	feature	which	allows	users	to
make	a	copy	of	the	full	document.	Another	way	to	duplicate	a	page	in	Google	Docs	is	by	simply	copying	and	pasting	all	texts	and	elements	on	a	particular	page	and	then	pasting	them	on	another	page	in	the	same	document	or	a	separate	document.	Other	Google	products	&	services	How	to	turn	off	tilt	view	in	Google	Maps	Google	reverse	image	search:
mobile,	iPhone,	Android,	app	How	to	get	street	view	on	Google	Earth:	VR,	app,	iPhone	How	to	use	Google	Earth	flight	simulator	Download	offline	Google	Maps:	iPhone,	for	PC,	Android	How	to	get	Google	Docs	to	read	to	you:	Google	text-to-speech	How	to	enable	Google	Drive	OCR:	PDF,	scan,	search	New	AI	features	in	Google	apps:	Bard,
ImmersiveView,	Lens	Everything	about	Google	Meet:	how	to	use	it,	breakout	rooms	How	to	remove	Google	Drive:	from	PC,	startup,	Windows	10	What	is	Emoji	Kitchen:	how	to	use,	Gboard,	Google	Search	How	to	change	the	language	in	Google	Drive	Restore	Google	Photos:	backup,	to	phone,	to	gallery	Google	Docs	spell	check:	not	working,	settings
Add	and	edit	images	in	Google	Docs:	rotate,	resize,	adjust	How	to	translate	a	page	on	Android	with	Google	Translate	Plan	a	route	on	Google	Maps:	app,	Android,	iPhone	Compress	images	with	Google	Squoosh	VLOGGER	AI:	Google	brings	your	still	photos	to	life	and	lets	you	control	them	with	your	voice	Google	Kids	Space:	features,	security,	devices
Google	I/O	2024:	what	it	is,	date,	program,	how	to	see	it,	Pixel	Everything	about	Gemini	AI:	Google's	assistant,	Nano,	Ultra	Web	How	do	you	duplicate	a	page	in	Google	Docs?	Do	you	copy	and	paste	the	text	from	one	document	to	another?	Well,	theres	an	easy	way	to	do	that!	Duplicating	a	page	in	Google	Docs	is	a	simple	way	to	make	multiple	copies	of
a	document	without	having	to	re-type	everything.	In	this	tutorial,	youll	learn	how	to	duplicate	a	page	in	Google	Docs.	Also	read:	(opens	in	new	tab)How	to	Jump	to	a	Page	in	Google	DocsHow	to	Rearrange	Pages	in	Google	DocsWhy	Are	My	Pages	Connected	in	Google	Docs?How	to	Show	Paragraph	Marks	in	Google	Docs	Click	on	File	Select	Make	a	copy
Rename	the	Copy	document	Click	on	the	Make	a	copy	button	Follow	these	steps	if	you	want	to	duplicate	a	page	in	the	same	Google	Doc	Follow	these	simple	steps	to	duplicate	a	page	in	Google	Docs:	The	first	step	is	to	open	the	Google	Doc	you	want	to	duplicate.	Now,	click	on	the	File	option	from	the	menu	bar.	After	you	click	on	the	File	option,	select
the	Make	a	copy	option	from	the	drop-down	menu.	Rename	the	duplicate	document	if	you	want	to.	By	default,	Google	Docs	will	save	the	duplicate	copy	with	the	name	Copy	of	(original	document	name)	in	your	Google	Drive.	You	also	have	the	option	to	copy	the	comments	and	suggestions	from	the	original	document.	Finally,	click	on	the	blue	Make	a
copy	button	from	the	pop-up	to	duplicate	the	document.	The	duplicate	document	will	now	be	opened	in	a	new	tab.	These	steps	will	make	a	copy	of	the	entire	document	in	your	Google	Drive.	However,	if	you	only	want	to	duplicate	the	page	within	the	same	document,	follow	the	instructions	below.	Note:	The	version	history	from	the	original	document
will	be	retained	in	your	duplicate	copy.	Learn	how	to	delete	version	history	in	Google	Docs.	To	duplicate	a	page	in	the	same	Google	Doc,	select	all	of	the	content	on	that	page	with	the	mouse	pointer,	and	press	Ctrl+C,	then	go	to	the	page	where	you	want	to	paste	the	content	and	press	Ctrl+V.	Can	You	Duplicate	a	Page	in	Google	Docs?Yes,	you	can
duplicate	a	page	in	Google	Docs.	How	to	Duplicate	a	Document	in	Google	Docs?Go	to	File	>	Make	a	copy	>	Rename	>	Make	a	copy.	How	Do	You	Duplicate	a	Single	Page	in	Google	Docs?Copy	the	content	from	the	page	and	then	paste	it	to	a	new	page.	How	to	Copy	Entire	Pages	in	Google	Docs?To	copy	the	entire	page	in	Google	Docs,	press	Ctrl+A	and
then	Ctrl+C.	How	to	Cut	and	Paste	Entire	Page	in	Google	Docs?Select	the	full	pages	content,	then	use	Ctrl+X	to	cut	the	content,	and	then	Ctrl+V	on	a	new	page	to	paste	the	content.In	this	article,	you'll	learn	how	to	create	a	duplicate	of	your	Google	Doc.1.	Start	by	navigating	to	the	File	option	in	the	topmost	toolbar.2.	From	the	drop-down	menu,
select	Make	a	Copy.	This	action	duplicates	your	entire	Google	Doc	into	a	separate	copy.FAQs1.	Does	"Make	a	Copy"	duplicate	all	the	content	in	the	Google	Doc?Yes,	selecting	"Make	a	Copy"	duplicates	all	the	content,	including	text,	images,	and	formatting,	into	a	new	Google	Doc.2.	Can	I	rename	the	copied	Google	Doc?Yes,	after	making	a	copy,	you
can	rename	the	new	Google	Doc	as	per	your	preference.3.	Does	the	original	Google	Doc	get	affected	when	I	make	a	copy?No,	making	a	copy	does	not	affect	the	original	Google	Doc.	It	remains	intact.Often,	when	we	are	working,	the	overflow	of	ideas	leads	us	to	contemplate	whether	making	changes	to	the	original	document	or	creating	a	new	one
would	be	more	effective.	Alternatively,	when	collaborating	and	receiving	suggestions	for	changes	from	colleagues,	incorporating	them	directly	into	the	original	document	may	not	be	the	most	viable	option.	Google	Docs	provides	numerous	features,	and	in	such	situations,	duplicating	a	page	can	be	immensely	useful.	In	this	article,	our	focus	will	be	on
how	to	duplicate	a	single	page	or	multiple	pages	in	Google	Docs	within	the	same	document	to	enhance	our	work	performance.	Duplicate	a	Page	in	Google	DocsHow	to	Duplicate	one	single	Page	in	Google	DocsDuplicating	a	single	page	in	Google	Docs	or	making	a	copy	is	a	convenient	method	for	efficiently	organizing	and	managing	your	content.	The
question	then	arises:	How	can	this	be	done?	This	step-by-step	guide	simplifies	the	process,	ensuring	you	can	effortlessly	replicate	pages	for	enhanced	document	management.Step	1:	Open	the	Google	document	on	your	computer	that	you	want	to	duplicate.	Google	Docs	InterfaceStep	2:	After	opening	the	document,	select	the	text	you	want	to	copy,	then
press	"CTRL+C"	to	copy	it.	Select	the	Text	in	Google	DocsStep	3:	In	the	menu	bar,	click	on	the	"Insert"	tab.	Google	Docs	Insert	TabStep	4:	From	the	drop-down	menu,	scroll	down	and	select	"Break.	Google	Docs	BreakStep	5:	In	the	side	menu	that	appears,	navigate	to	and	click	on	"Section	break	(next	page)".	This	will	create	a	section	break,	ensuring
the	next	content	starts	on	a	new	page.	Step	6:	A	new	page	will	be	formed.	Google	Docs	New	PageStep	7:	Now,	on	the	new	page	created	by	the	section	break,	press	"CTRL+V"	to	paste	the	copied	content	into	this	section.	Google	Docs	Duplicating	a	PageStep	8:	There	you	go!	You	have	successfully	duplicated	a	page	in	Google	Docs.	Google	Docs
Duplicating	a	Page	How	to	Duplicate	Entire	Pages	in	Google	DocsDuplicating	your	entire	document	in	Google	Docs	offers	a	quick	and	efficient	way	to	create	backups	and	experiment	with	edits	without	affecting	the	original.	In	this	section,	we	will	be	guiding	you	on	how	to	do	just	that	seamlessly!Step	1:	Open	the	Google	document	you	wish	to
replicate.	Google	Docs	InterfaceStep	2:	In	the	menu	bar,	click	on	"File".	Google	Docs	File	TabStep	3:	From	the	dropdown	menu,	select	"Make	a	copy".	Google	Docs	Make	a	copy	optionStep	4:	When	prompted,	take	a	moment	to	give	a	distinctive	and	meaningful	name	to	the	replicated	document.	Google	Docs	Naming	a	Copy	documentStep	5:
Congratulations!	You've	successfully	created	a	copy	of	your	existing	document.Google	Docs	Make	a	copy	exampleBest	Free	Alternative	to	Google	Docs	-	WPS	OfficeOne	of	the	significant	challenges	faced	by	Google	Docs	is	its	dependence	on	internet	connectivity.	Despite	its	feature-packed	capabilities,	Google	Docs	can	become	impractical	with	poor
internet	connections.	If	you've	encountered	this	issue	and	are	exploring	alternatives,	the	WPS	Office	Suite	is	a	suitable	option.	Much	like	Google	Docs,	WPS	Office	is	free	to	use,	requiring	no	trials	or	cumbersome	processes.	Simply	download	it	directly,	and	it's	ready	for	all	your	office	needs.	Moreover,	WPS	Office	is	available	across	major	platforms,
including	macOS,	Linux,	Windows,	and	mobile	platforms.A	critical	consideration	when	migrating	to	new	office	suites	is	compatibility.	WPS	Office	addresses	this	concern	with	its	extensive	compatibility	with	Microsoft	Office	and	Google	Suites	files.	Beyond	compatibility,	WPS	Office	offers	additional	benefits	as	an	all-in-one	office	suite	with	robust	PDF
tools.	It	goes	beyond	mere	PDF	viewing,	allowing	users	to	edit,	save,	and	share	their	PDF	files	seamlessly.WPS	Office	WriterWPS	Office	significantly	enhances	both	online	and	offline	work	capabilities,	serving	as	a	powerful	office	suite	that	efficiently	gets	the	job	done	without	any	cost	constraints.	It's	a	choice	embraced	by	millions	worldwide.
Download	WPS	Office	now	and	become	part	of	the	community	of	satisfied	users.Trustpilot4.8WPS	Office-	Free	All-in-One	Office	SuiteUse	Word,	Excel,	and	PPT	for	FREE,	No	Ads.Edit	PDF	files	with	the	powerful	PDF	toolkit.Microsoft-like	interface.	Easy	to	learn.	100%	Compatibility.Boost	your	productivity	with	WPS's	abundant	free	Word,	Excel,	PPT,
and	CV	templates.5.820.008UserAlgirdas	JasaitislogoFAQsQ1.	How	to	duplicate	a	page	in	Google	Slides?To	duplicate	a	page	in	Google	Slides,	follow	these	simple	steps:Step	1:	Launch	Google	Slides	and	open	your	presentation.Step	2:	On	the	left-hand	panel,	click	the	slide	you	want	to	duplicate.Step	3:	Right-click	on	the	slide	and	select	Duplicate	slide
from	the	displayed	options.Q2.	How	to	delete	a	page	in	Google	DocsTo	delete	a	page	in	Google	Docs,	follow	these	straightforward	steps:Step	1:	Launch	Google	Docs	and	open	your	document.Step	2:	Click	on	the	page	you	want	to	delete	to	position	your	cursor	at	the	beginning.Step	3:	Press	the	"Backspace"	or	"Delete"	key	on	your	keyboard	until	the
page	is	deleted.Q3.	Why	would	I	need	to	duplicate	a	page	in	Google	Docs?Duplicating	a	page	in	Google	Docs	proves	invaluable	for	preserving	a	uniform	format	and	efficiently	replicating	content.	This	functionality	streamlines	document	creation	by	providing	a	quick	and	convenient	method	for	reproducing	consistent	layouts	or	recurring
information.Duplication	Mastery	UnleashedLearning	how	to	duplicate	pages	in	Google	Docs	is	a	game-changer	for	efficient	document	management.	Our	step-by-step	guide	simplifies	the	process,	enabling	seamless	replication	of	content	for	enhanced	collaboration	and	idea	exploration.	Considering	challenges	in	Google	Docs'	internet	dependency,	WPS
Office	emerges	as	a	user-friendly	alternative,	offering	compatibility	and	versatile	PDF	tools.	Experience	the	simplicity	of	WPS	Office	by	downloading	it	directly	a	cost-free	solution	embraced	by	millions	worldwide.	Of	course,	you	can	also	use	formulas	to	find	&	remove	duplicates	in	Google	Sheets.	Their	main	advantage	is	that	your	original	table
remains	intact.	The	formulas	identify	duplicates	and	return	the	result	to	some	other	place	in	your	Google	Sheets.	And	based	on	the	desired	outcome,	different	functions	do	the	trick.	The	UNIQUE	function	scans	your	data,	deletes	duplicates	and	returns	exactly	what	its	name	says	unique	values/rows.	Here's	a	small	sample	table	where	different	rows
reoccur:	On	one	hand,	you	may	need	to	remove	all	duplicate	rows	from	this	Google	Sheets	table	and	keep	only	the	first	entries.	To	do	that,	just	enter	the	range	for	your	data	inside	UNIQUE:	=UNIQUE(A1:C10)	This	small	formula	returns	all	unique	rows	and	all	1st	occurrences	ignoring	2nd,	3rd,	etc.	On	the	other	hand,	you	may	want	to	get	only	the
"real"	unique	rows.	By	"real"	I	mean	those	that	don't	reoccur	not	even	once.	So	what	do	you	do?Let's	take	a	moment	and	look	through	all	UNIQUE	arguments:UNIQUE(range,[by_column],[exactly_once])range	is	the	data	you	want	to	process.[by_column]	tells	whether	you	check	for	completely	matching	rows	or	cells	in	individual	columns.	If	it's
columns,	enter	TRUE.	If	it's	rows,	enter	FALSE	or	just	skip	the	argument.[exactly_once]	this	one	tells	the	function	to	delete	not	only	duplicates	in	Google	Sheets	but	also	their	1st	entries.	Or,	in	other	words,	return	only	records	with	no	duplicates	whatsoever.	For	that,	you	put	TRUE,	otherwise	FALSE	or	skip	the	argument.That	last	argument	is	your
leverage	here.Hence,	to	remove	all	duplicate	rows	from	your	Google	Sheets	completely	(along	with	their	1st	),	skip	the	second	argument	in	the	formula	but	add	the	third:=UNIQUE(A1:C10,,TRUE)See	how	the	table	on	the	right	is	much	shorter?	It's	because	Google	Sheets	UNIQUE	found	and	removed	duplicate	rows	as	well	as	their	1st	occurrences
from	the	original	table.	Only	unique	rows	remain	now.	If	wasting	cells	with	another	dataset	is	not	part	of	your	plan,	you	can	count	duplicates	in	Google	Sheets	instead	(and	then	delete	them	manually).	It'll	take	just	one	extra	column	and	the	COUNTIF	function	will	help.Tip.	If	you're	not	familiar	with	this	function,	we	have	an	entire	blog	post	about	it,
feel	free	to	take	a	look.	Let's	identify	all	duplicates	with	their	1st	occurrences	in	Google	Sheets	and	check	the	total	number	of	each	berry	appearing	on	the	list.	I	will	enter	the	following	formula	in	D2	and	then	copy	it	down	the	column:=COUNTIF($B$2:$B$10,$B2)Tip.	To	make	this	formula	handle	each	row	in	the	column	automatically,	wrap	everything
in	ArrayFormula	and	change	$B2	to	$B2:$B10	(the	whole	column).	Thus,	you	won't	need	to	copy	the	formula	down:If	afterwards	you	filter	this	dataset	by	the	numbers,	you	will	be	able	to	see	and	even	remove	all	duplicate	rows	from	your	Google	Sheets	table	manually:	In	case	the	total	number	of	occurrences	is	not	your	goal	and	you'd	rather	know
whether	this	particular	record	in	this	particular	row	is	the	1st,	2nd,	etc	entry,	you'll	need	to	make	a	slight	adjustment	to	the	formula.Change	the	range	from	the	entire	column	($B$2:$B$10)	to	just	one	cell	($B$2:$B2).Note.	Pay	attention	to	the	use	of	absolute	references.=COUNTIF($B$2:$B2,$B2)Now	deleting	duplicates	from	this	Google	Sheets	table
will	be	even	easier	because	you'll	be	able	to	hide	all	entries	but	the	1st	ones:	All	previous	formulas	count	duplicates	in	a	single	Google	Sheets	column.	But	I	know	a	formula	that	looks	into	all	columns	to	identify	duplicate	rows.In	this	case,	COUNTIFS	will	suit	you	better.	Just	list	every	column	of	your	table	along	with	its	corresponding
criteria:=COUNTIFS($A$2:$A$10,$A2,$B$2:$B$10,$B2,$C$2:$C$10,$C2)Tip.	There's	another	way	available	to	calculate	duplicates	without	formulas.	It	involves	a	Pivot	table	and	I	described	it	above.	Sometimes	numbers	are	just	not	enough.	Sometimes	it's	better	to	find	duplicates	and	mark	them	in	a	status	column.	You	can	filter	this	column	by
statuses	and	remove	those	duplicates	you	no	longer	need.	For	this	task,	you	will	need	the	same	COUNTIF	function	but	this	time	wrapped	in	the	IF	function.	Just	like	this:=IF(COUNTIF($B$2:$B$10,$B2)>1,"Duplicate","Unique")Let's	see	what	happens	in	this	formula:First,	COUNTIF	searches	the	entire	column	B	for	the	berry	from	B2.	Once	found,	it
sums	them	up.Then,	IF	checks	this	total,	and	if	it's	greater	than	1,	it	says	Duplicate,	otherwise,	Unique.Of	course,	you	can	make	the	formula	to	return	your	own	statuses,	for	example,	find	&	identify	only	duplicates	in	your	Google	Sheets	data:=IF(COUNTIF($B$2:$B$10,$B2)>1,"Duplicate","")Tip.	As	soon	as	you	find	these	duplicates,	you	can	filter	the
table	by	the	status	column.	This	way	lets	you	hide	repeated	or	unique	records,	and	even	select	entire	rows	&	delete	these	duplicates	from	your	Google	Sheets	completely:	Similarly,	you	can	mark	absolute	duplicate	rows	rows	where	all	records	in	all	columns	appear	several	times	in	the	table:Start	with	the	same	COUNTIFS	from	before	the	one	that
scans	each	column	for	its	first	value	and	counts	only	those	rows	where	all	3	records	in	all	3	columns	repeat	themselves:	=COUNTIFS($A$2:$A$10,$A2,$B$2:$B$10,$B2,$C$2:$C$10,$C2)	Then	enclose	that	formula	in	IF.	It	checks	the	number	of	repeated	rows	and	if	it	exceeds	1,	the	formula	names	the	row	as	a	duplicate:
=IF(COUNTIFS($A$2:$A$10,$A2,$B$2:$B$10,$B2,$C$2:$C$10,$C2)>1,"Duplicate","")	Now	this	table	has	only	2	dupes.	Even	though	cherry	occurs	3	times	in	a	table,	only	two	of	them	have	all	3	columns	identical.	To	ignore	the	1st	occurrence	and	mark	only	the	2nd	and	the	other	ones,	refer	to	the	first	cells	of	the	table	instead	of	the	entire
columns:=IF(COUNTIFS($A$2:$A2,$A2,$B$2:$B2,$B2,$C$2:$C2,$C2)>1,"Duplicate","")Tip.	If	you	are	using	Microsoft	Excel,	the	following	examples	might	be	helpful:	How	to	find	duplicates	in	Excel.	Did	you	know	that	you	can	spot	duplicates	in	your	table	at	a	single	glance?	All	you	need	to	do	is	highlight	duplicates	in	Google	Sheets.	Conditional
formatting	will	help	you	with	this.Tip.	Visit	this	tutorial	for	more	formulas	to	highlight	duplicates	in	Google	Sheets.Here's	what	you	need	to	do:Open	conditional	formatting	settings:	Format	>	Conditional	formatting.Make	sure	that	the	Apply	to	range	field	contains	the	range	of	cells	where	you	want	to	highlight	duplicates.	For	this	example,	let	me	start
with	column	B.In	Format	rules	pick	Custom	formula	is	and	enter	the	same	COUNTIF	that	I	introduced	above:	=COUNTIF($B$2:$B$10,$B2)>1	Once	it	locates	records	that	appear	at	least	twice	in	column	B,	they	will	be	colored	with	a	hue	of	your	choice:Another	option	would	be	to	highlight	duplicate	rows.	Simply	adjust	the	range	to	apply	the	rule	to
multiple	columns:Tip.	Once	you	highlight	duplicates	in	your	Google	Sheets,	you	can	filter	the	data	by	color:On	one	hand,	you	can	filter	the	column	so	that	only	cells	with	the	white	fill	color	remain	visible.	This	way,	you	will	delete	duplicates	from	the	view:	On	the	other	hand,	you	can	keep	only	colored	cells	visible:	and	then	select	these	rows	and	delete
these	duplicates	from	your	Google	Sheets	completely:	Find	&	remove	duplicates	in	Google	Sheets	(make	yourself	a	copy	to	practice)	Duplicating	a	Google	Doc	might	seem	like	a	simple	task	at	first	glance,	but	it's	surprisingly	packed	with	useful	techniques	and	benefits.	Whether	you're	working	on	a	group	project,	creating	templates,	or	just	want	a
backup	of	your	work,	knowing	how	to	effectively	duplicate	a	document	can	save	you	loads	of	time	and	effort.	Let's	explore	different	ways	to	achieve	this	and	make	your	Google	Docs	experience	a	little	easier.	Before	diving	into	the	how-to,	let's	chat	about	the	why.	You	might	think,	"Why	would	I	need	a	duplicate	of	my	document?"	Well,	there	are	several
practical	reasons	for	duplicating	a	Google	Doc:Creating	Templates:	If	you	frequently	generate	similar	documents,	having	a	template	can	streamline	your	workflow	significantly.	By	duplicating	a	well-structured	document,	you'll	have	a	ready-made	template	to	adapt	whenever	you	need	it.Version	Control:	Maybe	you're	experimenting	with	different
drafts	or	ideas.	Duplicating	your	document	allows	you	to	make	significant	changes	without	losing	the	original	version.Collaboration:	Sometimes,	you	need	to	share	a	document	for	collaboration	while	keeping	the	original	intact.	Duplicating	can	provide	a	clean	slate	for	team	edits	while	preserving	your	initial	work.Backup:	Keeping	a	duplicate	can	serve
as	a	handy	backup	in	case	you	accidentally	delete	or	significantly	alter	your	original	document.	Now	that	we	understand	the	practical	benefits,	let's	look	at	how	to	create	a	duplicate	of	your	Google	Doc.Making	a	Copy:	The	Basics	The	most	straightforward	way	to	duplicate	a	Google	Doc	is	by	using	the	"Make	a	copy"	feature.	Here's	how	you	can	do
it:Open	Your	Document:	Navigate	to	the	Google	Doc	you	want	to	duplicate.	This	document	will	be	the	source	of	your	new	copy.Access	the	File	Menu:	Click	on	File	in	the	top-left	corner	of	the	screen	to	open	a	dropdown	menu.Select	"Make	a	copy":	From	the	dropdown	menu,	choose	Make	a	copy.	A	dialog	box	will	appear,	prompting	you	to	name	your
new	document.Name	Your	Copy:	Enter	a	name	for	your	duplicate	document.	It's	a	good	idea	to	choose	something	descriptive	so	you	can	easily	identify	it	later.Choose	a	Location:	You	can	modify	the	location	of	the	new	copy	by	selecting	a	different	folder	within	your	Google	Drive.	This	step	is	optional,	but	organizing	your	documents	can	be	quite
helpful.Click	"OK":	Once	you're	satisfied	with	the	name	and	location,	click	OK	to	create	your	duplicate	document.	And	just	like	that,	you	have	a	new	copy	of	your	original	Google	Doc.	It's	a	straightforward	process	that	you	can	use	anytime	you	need	a	duplicate.Using	Google	Drive	to	Duplicate	If	you	spend	a	lot	of	time	in	Google	Drive,	duplicating
documents	directly	from	there	can	be	more	convenient.	Here's	how	to	do	it:Open	Google	Drive:	Navigate	to	Google	Drive	and	locate	the	document	you	want	to	duplicate.Right-Click	the	Document:	Once	you	find	the	document,	right-click	on	it	to	open	a	context	menu.Select	"Make	a	copy":	In	the	context	menu,	you'll	see	an	option	labeled	Make	a	copy.
Click	it.Rename	Your	Copy:	Google	Drive	will	create	a	copy	with	the	prefix	"Copy	of"	before	the	original	document's	name.	You	might	want	to	rename	it	to	something	more	specific.Organize	Your	Copy:	Move	your	new	document	to	a	different	folder	if	needed	for	better	organization.	This	method	is	particularly	useful	if	you're	managing	multiple
documents	and	prefer	to	handle	file	operations	directly	within	Google	Drive.	Sometimes,	you	need	to	duplicate	a	document	that	someone	else	has	shared	with	you.	This	process	is	slightly	different	because	you	may	not	have	full	editing	permissions.	Here's	how	to	make	a	copy	of	a	shared	document:Open	the	Shared	Document:	Click	the	link	to	the
shared	Google	Doc	provided	by	the	owner.Sign	In:	Make	sure	you're	signed	in	to	your	Google	account,	or	you	won't	have	the	option	to	make	a	copy.Go	to	File:	Like	before,	click	File	in	the	top-left	corner	of	the	document.Select	"Make	a	copy":	In	the	dropdown	menu,	choose	Make	a	copy.Name	Your	Copy:	Assign	a	new	name	to	your	duplicate
document.Choose	a	Location:	Decide	where	you	want	to	save	your	copy	in	Google	Drive.Click	"OK":	Complete	the	process	by	clicking	OK.	Remember,	if	the	document	owner	has	restricted	permission	settings,	you	may	not	have	all	options	available	to	you.	In	such	cases,	you	might	need	to	request	additional	permissions	or	download	the	document	as	a
different	file	type.Using	Keyboard	Shortcuts	for	Quick	Duplication	If	you're	a	fan	of	keyboard	shortcuts,	you're	in	luck.	Google	Docs	offers	some	quick	key	combinations	to	speed	up	the	process	of	duplicating	documents.	Here's	a	handy	shortcut	method:Select	the	Document:	Use	your	mouse	or	trackpad	to	highlight	the	document	you	wish	to
duplicate.Keyboard	Shortcut:	Press	Ctrl	+	C	to	copy	the	document,	then	press	Ctrl	+	V	to	paste	the	copy	into	the	same	folder.Rename	the	Copy:	Google	Drive	will	automatically	name	the	copy	with	the	prefix	"Copy	of."	Feel	free	to	rename	it	to	suit	your	needs.	While	this	method	might	seem	like	it's	for	the	pros,	it's	actually	quite	simple	once	you	get
the	hang	of	it.	Plus,	it's	a	real	time-saver	when	you're	managing	multiple	documents.Duplicating	Documents	for	Collaboration	Collaboration	is	one	of	the	best	features	of	Google	Docs,	but	sometimes	you	need	a	fresh	version	of	a	document	to	start	over	with	a	new	team	or	project.	Here's	how	you	can	use	duplicates	in	collaborative	settings:Create	a
Copy:	Use	any	of	the	methods	we've	discussed	to	make	a	copy	of	your	document.Rename	and	Organize:	Give	your	duplicate	document	a	new	name	and	organize	it	in	a	way	that	makes	sense	for	your	project.Share	the	Duplicate:	Click	on	the	Share	button	in	the	top-right	corner	of	the	document.	Enter	the	email	addresses	of	your	collaborators	and	set
the	appropriate	permissions	(view,	comment,	or	edit).Collaborate:	Once	shared,	your	team	can	start	working	on	the	document	together,	making	changes	and	adding	comments	as	needed.	This	approach	is	particularly	beneficial	when	you're	collaborating	on	a	document	that	needs	to	go	through	multiple	iterations	or	when	each	team	member	needs
their	own	version	to	work	from.	Version	control	is	crucial	when	working	on	important	documents,	especially	those	that	require	multiple	revisions.	Duplicating	your	Google	Docs	can	help	you	maintain	a	clear	record	of	changes.	Here's	how	you	can	use	this	feature	for	version	control:Duplicate	the	Document:	As	you	reach	significant	milestones	in	your
document,	make	a	copy	to	preserve	that	version.Rename	for	Clarity:	Give	each	version	a	distinct	name	that	reflects	the	stage	of	development,	such	as	"Draft	1,"	"Final	Version,"	or	"Client	Review."Organize	Versions:	Create	a	dedicated	folder	in	Google	Drive	to	hold	all	the	document	versions.	This	way,	you	can	easily	track	your	progress.Review	and
Compare:	Use	the	version	history	feature	in	Google	Docs	to	compare	different	versions	and	track	changes	over	time.	With	this	strategy,	you'll	have	a	clear	record	of	your	document's	evolution,	which	can	be	invaluable	when	reflecting	on	changes	or	presenting	your	work	to	others.Backing	Up	Important	Documents	Accidents	happen,	and	sometimes
files	get	lost	or	corrupted.	Duplicating	your	Google	Docs	can	serve	as	a	safety	net.	Here's	how	you	can	use	duplicates	for	backup	purposes:Create	a	Copy:	Make	a	duplicate	of	your	important	document	using	your	preferred	method.Store	in	a	Safe	Location:	Move	your	duplicate	to	a	dedicated	backup	folder	or	an	external	storage	option.Regular
Updates:	Periodically	update	your	backup	copy	to	ensure	it	reflects	the	latest	version	of	your	work.Additional	Security:	Consider	using	an	encrypted	storage	solution	for	sensitive	documents	to	enhance	security.	By	keeping	duplicates	of	essential	documents,	you'll	reduce	the	risk	of	data	loss	and	ensure	that	you	always	have	access	to	your	work,	even
in	unforeseen	circumstances.	Now,	while	duplicating	Google	Docs	is	quite	straightforward,	imagine	if	your	document	management	could	be	even	more	efficient.	That's	where	Spell	comes	into	play.	With	Spell,	you	can	create,	edit,	and	share	your	documents	much	faster.	It's	like	having	Google	Docs,	but	with	AI	built	in,	allowing	you	to	draft,	refine,	and
collaborate	on	documents	effortlessly.	With	Spell,	you	can	quickly	generate	high-quality	drafts,	edit	them	using	natural	language	prompts,	and	collaborate	with	your	team	in	real	time.	It	eliminates	the	hassle	of	copying	and	pasting	between	different	tools	and	ensures	your	work	remains	well-formatted	and	professional.	Plus,	you	won't	have	to	worry
about	document	formatting	headaches	or	broken	text	-	all	these	processes	are	seamless	with	Spell.	Incorporating	Spell	into	your	workflow	can	be	a	game-changer,	making	document	management	more	efficient	and	less	time-consuming.Final	Thoughts	Duplicating	a	Google	Doc	is	a	handy	skill	that	can	simplify	tasks	like	creating	templates,	managing
versions,	and	collaborating	with	others.	It's	something	every	Google	Docs	user	should	know.	And	while	duplicating	is	straightforward,	using	Spell	can	make	the	whole	process	even	smoother	by	helping	you	draft,	edit,	and	collaborate	in	real	time.	It's	like	having	a	supercharged	version	of	Google	Docs	at	your	fingertips,	making	your	document	creation
and	management	faster	and	more	effective.Creating	address	labels	in	Google	Docs	might	seem	like	a	complex	task,	but	it's	actually	quite	straightforward	once	you	get	the	hang	of	it.	Whether	you're	planning	a	wedding,	sending	out	holiday	cards,	or	organizing	a	mailing	list	for	your	business,	having	a	streamlined	method	for	producing	labels	can	be	a
real	time-saver.Google	Docs	is	a	fantastic	tool	for	creating	and	editing	documents	online,	but	sometimes	the	features	you	need	aren't	immediately	obvious.	One	such	feature	is	using	small	caps	to	give	your	text	a	unique	and	professional	look.Google	Docs	and	its	cloud-based	convenience	have	become	a	staple	for	individuals	and	teams	alike.	But	what	if
you	need	to	convert	that	Google	Doc	into	a	file	format	that	can	be	shared	or	stored	offline?Google	Docs	is	a	familiar	friend	to	many	of	us,	offering	a	simple	and	effective	way	to	create	and	manage	documents	online.	Whether	you're	working	on	a	school	essay,	a	business	report,	or	just	jotting	down	some	thoughts,	keeping	track	of	your	word	count	is
often	crucial.Working	with	Google	Docs	on	your	phone	can	be	incredibly	convenient,	especially	when	you're	on	the	go.	But	what	happens	when	you	need	to	save	that	document	as	a	PDF?Google	Docs	can	be	a	lifesaver	when	it	comes	to	organizing	your	thoughts,	whether	you're	drafting	a	report,	creating	a	lesson	plan,	or	jotting	down	notes	for	that
novel	you've	been	meaning	to	start.	But	to	keep	things	tidy	and	easy	to	navigate,	adding	headings	to	an	outline	is	a	game-changer.	If	you	want	to	copy	a	document	in	Google	Docs,	well	show	you	2	easy	ways	to	do	it.	If	youre	trying	to	copy	parts	of	a	document	(for	example,	duplicating	a	page	within	a	multi-page	Google	Doc),	thats	a	little	more	difficult.
But	dont	worry,	we've	got	you	covered.How	to:	1.	How	to	duplicate	a	Google	Doc	(copy	the	entire	document)If	you	just	want	to	make	a	copy	of	a	Google	Doc,	open	the	doc	and	select	File	>	Make	a	copy.At	that	point,	youll	have	the	option	to:Rename	the	new	Google	Doc	that	you	just	duplicated	otherwise,	the	default	name	is	Copy	of	[Original	Doc
Name]Move	the	duplicated	Google	Doc	to	another	location	in	Google	Drive	(whether	thats	a	different	folder,	My	Drive,	Shared	drives,	a	synced	computer,	or	in	the	Shared	with	me	folder)Share	the	duplicated	Google	Doc	with	the	same	peopleCopy	comments	and	suggestionsInclude	resolved	comments	and	suggestionsFile	>	Make	a	copy	also	works	in
Google	Slides	&	Sheets	to	make	duplicates.Another	way	to	duplicate	a	Google	Doc	is	to	go	to	Home	(drive.google.com/home),	select	the	original	document,	and	right-click	OR	use	the	3-dot	menu	to	select	Make	a	copy.	You'll	see	the	same	options	to	rename	the	duplicate	Google	Doc,	move	it	to	another	location,	etc.	2.	How	to	duplicate	a	page	or	section
in	a	Google	DocIf	youre	only	trying	to	duplicate	a	portion	of	your	Google	Doc	not	the	entire	document	keep	reading	for	instructions.The	easiest	way	to	copy	a	page	or	section	within	a	Google	Doc	is	to	select	the	section	and	use	the	keyboard	shortcut	Cmd	+	C	(Mac)	or	Control	+	C	(Windows).	Then,	navigate	to	where	you	want	to	place	the	copied
section,	and	use	the	keyboard	shortcut	Cmd	+	V	(Mac)	or	Control	+	V	(Windows).	Or,	select	a	section,	right-click,	and	select	Copy	or	Paste.Wait,	my	duplicated	section	is	messed	up!Google	Docs	are	designed	to	have	text	flow	seamlessly	across	pages.	So	when	you	copy	&	paste	one	part	of	the	document,	the	duplicated	section	or	page	wont	necessarily
maintain	its	formatting	or	take	up	the	same	amount	of	room	in	the	document.The	best	workaround	is	to	use	page	breaks:Decide	where	you	want	the	duplicated	page	or	section	to	appear	in	your	document.In	the	top	left,	select	File	>	Insert	Page	Break.Copy	and	paste	your	original	page	or	section	in	the	newly	created	page.If	the	formatting	is	still
wrong,	try	pasting	without	formatting:	Cmd	+	Shift	+	V	(on	Mac)	OR	Control	+	Shift	+	V	(on	Windows).	3.	How	to	duplicate	Google	docs	for	your	team,	via	WorkonaMaybe	you	need	a	faster	way	to	duplicate	Google	Docs,	or	its	never	clear	which	doc	is	the	original	and	which	ones	are	duplicates.	A	lot	of	people	try	using	Google	Doc,	Sheet	or	Slide
templates	to	solve	these	problems.	Unfortunately,	the	built-in	doc	templates	in	Drive	are	difficult	for	team	members	to	find	plus,	they	require	a	paid	account	in	Google	Workspace.Instead,	try	doc	templates	in	Workona:You	can	choose	any	doc	in	Google	Drive	as	the	template	doc	(Workona	won't	alter	your	original	doc)You	can	automatically	replace
content	within	docs,	such	as	project	name,	due	date	&	client	informationSet	defaults	so	your	duplicated	docs	are	organized,	formatted	&	shared	correctly	every	timeAll	your	doc	templates	are	in	one	place,	easily	accessible	to	you	&	your	team	throughout	the	projectDoc	templates	can	duplicate	any	Google	doc	you	want	to	share	with	your	team,	such	as
a	creative	brief	template,	project	proposal	template,	client	offboarding	template,	etc.
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